Typical Traffic Control Plan

**Freeway Rolling Slowdown for 45 thru 70 MPH (Trucks 60) Zones**

**Rolling Slowdown Distance (Dm)**

1. **Starting Location**
   - Traveling at target speed, Vw
   - Field locate 1+/- mile prior to rolling slowdown starting point
   - PCMS message information: # mph = target speed
   - Next # miles = S.D. distance + 1 mile
   - Time to match hours of S.D.
   - Locate PCMS per standard spec.

2. **Rolling Slowdown Data** (Vw, Dm, and Ttarget)
   - Notes & Legend are available on Sheet 3.

**Phase 1 Rollin Slowdown Blockade Forms**

1. **Traffic Control**
   - Use TA or U.P.O. vehicle to block each on-ramp lane until rolling blockade
   - Use TA, PV, or U.P.O. vehicle to block each lane in blockade
   - Use PCMSs
   - Use PCMSs on each transportable attenuator

**Phase 2 Clear Gap Established Work Begins**

1. **Traffic Control**
   - Use TA or U.P.O. vehicle to block each lane in blockade
   - Use TA, PV, or U.P.O. vehicle to block each on-ramp lane until rolling blockade
   - Use PCMSs
   - Use PCMSs on each transportable attenuator

**Traffic Control**

- **Use TA or U.P.O. vehicle to** block each lane in blockade
- **Use PCMSs**
- **Use PCMSs on each transportable attenuator**
- **Use TA, PV, or U.P.O. vehicle to block each on-ramp lane until rolling blockade**
- **Use PCMSs**
- **Use PCMSs on each transportable attenuator**

**Freeway Rolling Slowdown Data** (Vw, Dm, and Ttarget)

- **Field locate** 1+/- mile prior to rolling slowdown starting point
- **PCMS message information**: # mph = target speed
- **Next # miles = S.D. distance + 1 mile**
- **Time to match hours of S.D.**
- **Locate PCMS per standard spec.**
**Typical Traffic Control Plan**

**Location:** Washington State

**Job Number:** 2

**State:** WA

**F.A. Project No.:** 10

**Personal Stamp:** STAMP

**Title:** Freeway Rolling Slowdown for 45 Thru 70 MPH (Trucks 60) Zones

**Table:**

<table>
<thead>
<tr>
<th>PCMS</th>
<th># MPH</th>
<th>ROLLING SLOWDOWN</th>
<th>MILES</th>
<th>TIME</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>4</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Notes & Legend:**

- Truck-Mounted PCMs are used on each Transitable Attenuator.
- Use PCMs on each Transitable Attenuator.
- See Notes 2, 8, 11, & 17

**Phase 3:**

**Work Finishing Blockade Nearing Work Area**

**Phase 4:**

**Work Finished ROLLING SLOWDOWN ENDS TRAFFIC QUEUE DISSIPATING**

**Rolling Slowdown Data (Vr, Da, and Tm):**

- Time to Match Hours of R.S.
- Next # Miles = R.S. Distance + 1 Mile
- Time to Match Hours of R.S.

---

**Use TA or U.P.O Vehicle to Block Each Lane in Blockade Traveling at Target Speed.**

**See Notes 7, 12**
1. This Traffic Control Plan is only applicable to Freeways.
2. This Rolling Slowdown Plan can be used in conjunction with applicable shoulder and lane closure traffic control plans.
3. Rolling Slowdowns should only be used for work operations when traditional forms of traffic control are not applicable.
4. Notify WSDOT, Washington State Patrol, and Transit (when applicable) and local police and emergency service agencies 72 hours in advance of non-emergency Rolling Slowdowns.
5. Develop contingency plans to accommodate emergency vehicles needing immediate accommodation past the Rolling Slowdown (such as those transporting patients in critical condition).
6. Notify the regional WSDOT Traffic Management Center prior to commencement of Rolling Slowdown and after it finishes.
7. Traffic Control Vehicles shall activate flashing amber lamps and U.P.O. vehicles red/blue lamps during Rolling Slowdown.
8. Radio or cellular communication between work crew, U.P.O., Chase vehicle, and moving blockade vehicles is required.

**Rolling Slowdown Restrictions**

**Permitted Days & Hours**
- Sunday thru Thursday = Nightly, 11:00PM to 4:00AM
- Saturday Night = 11:59PM to 5:00AM

Allowed only for the following work operations:
1. Utility Line Installation/Removal Over Freeway
2. During the removal of existing sign structure over freeway
3. To modify lane closures (such as 2 Left -> 2 Right) when reconfiguring lanes to switch traffic control is impractical such as the temporary reconfiguration of freeway or installing lead-in across all lanes for traffic control
4. Emergency roadway or bridge repairs having short work durations (less than 10 minutes)
5. Additional work activities as approved by WSDOT in writing

**Freeway Rolling Slowdown**

**Estimated Clear Time**

- At Work Area (Time)
- At Ramp Meter Signal Stop Bar (Present)
- On-Ramp (Time)

**Speed Limit**

- V (mph)
- V (mph) (Trucks 60)
- V (mph) (Trucks 70)

**Rolling Slowdown Duration**

- Distance (mi)

**Rolling Slowdown Target Speed**

- V (mph)
- V (mph) (Trucks 60)
- V (mph) (Trucks 70)

**PCMS Message Information**

- # of伸び MILES = R.S. DISTANCE + 1 MILE TIME TO MATCH HOURS OF R.S.

**PCMS Message**

- Traffic Hold on Ramp/Stopped Traffic Ahead
- Portable Changeable Message Sign

**Legend**

- Traffic Safety Drum
- Transportable Attenuator
- Protective Vehicle
- Portable Changeable Message Sign
- Uniform Police Officer Vehicle
- Traveling Public Vehicle

**Typical Traffic Control Plan**

**Work Area**

- See Notes 2, 8, 11, & 17

**Freeway Rolling Slowdown for 45 Thru 70 MPH (Trucks 60) Zones**

- Not to Scale

**Freeway Rolling Slowdown Starting Location**

- Begins when the target speed is reached at the Rolling Slowdown starting location.
**Freeway Rolling Slowdown for 45 thru 70 MPH (Trucks 60) Zones**

**NOT TO SCALE**

**Freeway Rolling Slowdown**

- **Rolling Slowdown Data** ($V_a, D_a,$ and $T_{slo}$)
- **Notes & Legend are available on Sheet 3.**

**Typical Traffic Control Plan**

- **Use TA or U.P.O. Vehicle to block each lane in blockage.**
- **See Notes 7, 13.**

**Phase 1**

**Rolling Slowdown Blockade Forms**

- **Use TA or U.P.O. Vehicle to block each on-ramp until rolling blockade reaches ramp then TA or U.P.O. joins blockade to block the added lane on mainline.**
- **See Notes 14-16.**

**Phase 2**

**Clear Gap Established Work Begins**

- **Use TA or U.P.O. Vehicle to block each on-ramp until rolling blockade.
  - See Notes 14-16.**

**Chase Vehicle Shall Stop Just Ahead of the Work Area and Honk the Horn Twice, Then Contractor May Begin Working Across All Lanes.**

**TERMINAL RAMP CLOSURE**

- **See Notes 2, 8, 11, & 17.**

**NOTES & LEGEND ARE AVAILABLE ON SHEET 3.**
### Typical Traffic Control Plan

**Job Number:** TC182

**State:** Washington

**Location:** Washington State Department of Transportation

---

### Phases:

**Phase 3:**

**Work Finishing Blockade Nearing Work Area**

- **PCMS:**
  - Truck-Mounted PCMs
  - 1
  - Rolling Slowdown Traffic Occurring Ahead
  - Time to Match Hrs of RS

- **Notes & Legend:** Available on Sheet 3.

**Phase 4:**

**Work Finished, Rolling Slowdown Queue Dissipating**

- **PCMS:**
  - Truck-Mounted PCMs
  - 1
  - Rolling Slowdown Traffic Occurring Ahead
  - 2
  - Drive Down Shoulder to Remain 0.5 +/- Mile in Advance of Traffic Queue
  - Optional if Shoulder Width Less Than 8 Feet.

---

**Freeway Rolling Slowdown for 45 thru 70 MPH (Trucks 60) Zones**

**NOT TO SCALE**

**PLOTTED BY:**

**ENTERED BY:**

**CHECKED BY:**

**DESIGNED BY:**

**PROJ. ENGR.:**

**REGIONAL ADM.:**

---

**PCMS Message Information:**

- # MPH = R.S. Target Speed
- Next # Miles = R.S. Distance + 1 Mile
- Time to Match Hrs of R.S.

---

**Notes & Legend:** Available on Sheet 3.
1. This traffic control plan is only applicable for freeways.

2. This rolling slowdown plan can be used in conjunction with applicable shoulder and lane closure traffic control plans.

3. Rolling slowdowns should only be used for work operations when traditional forms of traffic control are not applicable.

4. Notify WSDOT, Washington State Patrol, transit (when applicable), and local police and emergency service agencies.

5. Develop contingency plans to accommodate emergency vehicles needing urgent accommodation past the rolling slowdown (such as those transporting patients in critical condition).

6. Notify the Regional WSDOT Traffic Management Center prior to commencement of each rolling slowdown and after it finishes.


8. Radio or cellular communication between work crew, U.P.O., vehicle, and moving blockade vehicles is required.

9. Blockade vehicles should enter freeway 1.5+ miles in advance of starting location (prestaging on the on-ramp shoulder if feasible). Blockade vehicles will move into position to block all freeway lanes while traveling at freeway speed at 0.4+ miles (200+ feet) in advance of starting location. Blockade vehicles will geleate together (simply releasing the acceleration on the conventional as needed to keep blockade vehicles aligned) reaching the rolling slowdown target speed near the starting location.

10. The rolling slowdown duration begins when the target speed is reached at the rolling slowdown starting location.

11. If motorists bypass the rolling blockade then the U.P.O. vehicle (if present in the rolling blockades) may chase and attempt to stop them. The remaining blockade vehicles will Reposition to ensure there is at least one blocking vehicle per two lanes, as soon as possible contact the chase vehicle and work crew ASAP so workers can evacuate the roadway.

12. Allowable rolling blockade enhancements:
   * Block each lane and its shoulder(s) with two
   * Add U.P.O. vehicle(s) traveling just behind the rolling blockade to deter and, if necessary, chase and stop vehicles that attempt to bypass the blockade.

13. Except as a last resort during an emergency traffic shall not be stopped during rolling slowdowns. Avoid slowing the rolling blockade speed to 0.5 mph less than the target speed when making speed adjustments approaching the work area.

14. Block on-ramps prior to the paved on-ramp gore or at the ramp meter stop bar (if present).

15. When practical, consider closing freeway-to-freeway on-ramps with traffic control devices or U.P.O. vehicles. Devices will block each lane and shoulder(s) with two.

16. Traveling public vehicles (if present in the rolling blockade) may chase and stop vehicles that attempt to bypass the blockade.

17. If traffic control for lane closures is in place then the work area can extend across those closed lanes. Otherwise, work area shall extend across the paved shoulder with a transportable attenuator located 150-720 feet upstream.

**PHASE 5: CONFIRMATION THAT ROLLING SLOWDOWN TRAFFIC QUEUE HAS DISSIPATED**

**ROLLING SLOWDOWN DATA**

<table>
<thead>
<tr>
<th>Speed Limit (V[max])</th>
<th>60 MPH</th>
<th>65 MPH (TRUCKS 60)</th>
<th>70 MPH (TRUCKS 60)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rolling Slowdown Duration (T&lt;sub&gt;rolling&lt;/sub&gt;)</td>
<td>5 MINUTES 10 MINUTES 10 MINUTES 5 MINUTES 10 MINUTES</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rolling Slowdown Target Speed (V&lt;sub&gt;rolling&lt;/sub&gt;)</td>
<td>20 MPH 25 MPH 20 MPH 30 MPH 25 MPH</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**ROLLING SLOWDOWN**

**PCMS**

<table>
<thead>
<tr>
<th># Mph</th>
<th>Rolling Slowdown</th>
<th>Next # Mph</th>
<th>R.S. Distance</th>
<th>1 Mile Time to Match Hours of R.S.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.5 SEC</td>
<td>1.5 SEC</td>
<td>1.5 SEC</td>
<td>1.5 SEC</td>
<td></td>
</tr>
</tbody>
</table>

**NOTES**

- Actual number of lanes may vary.
- Radio or cellular communication between work crew, U.P.O., vehicle, and moving blockade vehicles is required.
- U.P.O. vehicle(s) traveling just behind the rolling blockade to deter and, if necessary, chase and stop vehicles that attempt to bypass the blockade.
- Traveling public vehicles (if present in the rolling blockade) may chase and stop vehicles that attempt to bypass the blockade.
- If traffic control for lane closures is in place then the work area can extend across those closed lanes. Otherwise, work area shall extend across the paved shoulder with a transportable attenuator located 150-720 feet upstream.

**REGIONAL ADM.**

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>FILE NAME</th>
<th>PCMS</th>
<th>LEGEND</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/14/2022</td>
<td>1:20:33 PM</td>
<td>C:\Users\LintzF\OneDrive - Washington State Department of Transportation\Desktop\Work Zone TCPs\182FwyRS.dgn</td>
<td>PCMS</td>
<td>PORTABLE CHANGEABLE MESSAGE SIGN</td>
</tr>
</tbody>
</table>

**TC182**

**Typical Traffic Control Plan**

**Washington State Department of Transportation**

**Typical Traffic Control Plan**

**TYPICAL TRAFFIC CONTROL PLAN**

**NOT TO SCALE**

**REGIONAL ADM.**

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>FILE NAME</th>
<th>PCMS</th>
<th>LEGEND</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/14/2022</td>
<td>1:20:33 PM</td>
<td>C:\Users\LintzF\OneDrive - Washington State Department of Transportation\Desktop\Work Zone TCPs\182FwyRS.dgn</td>
<td>PCMS</td>
<td>PORTABLE CHANGEABLE MESSAGE SIGN</td>
</tr>
</tbody>
</table>

**TC182**

**Typical Traffic Control Plan**

**Washington State Department of Transportation**

**Typical Traffic Control Plan**

**TYPICAL TRAFFIC CONTROL PLAN**

**NOT TO SCALE**

**REGIONAL ADM.**

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>FILE NAME</th>
<th>PCMS</th>
<th>LEGEND</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/14/2022</td>
<td>1:20:33 PM</td>
<td>C:\Users\LintzF\OneDrive - Washington State Department of Transportation\Desktop\Work Zone TCPs\182FwyRS.dgn</td>
<td>PCMS</td>
<td>PORTABLE CHANGEABLE MESSAGE SIGN</td>
</tr>
</tbody>
</table>

**TC182**

**Typical Traffic Control Plan**

**Washington State Department of Transportation**

**Typical Traffic Control Plan**

**TYPICAL TRAFFIC CONTROL PLAN**

**NOT TO SCALE**

**REGIONAL ADM.**

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>FILE NAME</th>
<th>PCMS</th>
<th>LEGEND</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/14/2022</td>
<td>1:20:33 PM</td>
<td>C:\Users\LintzF\OneDrive - Washington State Department of Transportation\Desktop\Work Zone TCPs\182FwyRS.dgn</td>
<td>PCMS</td>
<td>PORTABLE CHANGEABLE MESSAGE SIGN</td>
</tr>
</tbody>
</table>
UPDATED WORK ZONE MICROSTATION CELLS:

IMPORTANT: An extensive library of updated work zone cells are now available for work zone signs, detour signs (generic and route-specific), tables, legend, and symbols. Use these updated cells in all traffic control plans. For the Typical Traffic Control Plan, the updated cells have been incorporated. Color and grayscale PDFs of work zone cells are available on the WSDOT Typical Traffic Control Plans webpage (https://www.wsdot.wa.gov/Design/Standards/PlanSheet/Work-Zone/Typical-TCPs.htm).

WSDOT Staff:
1. Cell libraries are automatically updated by CAE.
2. Manually update or replace Microstation cells at least annually. See https://www.wsdot.wa.gov/Design/CAE/Technotes.htm for technical support and guidance.

External Cells (e.g., local agencies, design-build contractors, and consultants):
2. Manually update or replace Microstation cells at least annually. See https://www.wsdot.wa.gov/Design/CAE/Technotes.htm for technical support and guidance.

PRINTING IN FULL COLOR OR GRAYSCALE (BLACK/WHITE):

Even though the work zone cells are full color, CAE has programmed a color (224-239) used for the new work zone cells and the left edge line of the work zone to print in grayscale automatically when designers print in black/white.

For this to function (otherwise it will print out as a solid black glob), DESIGNERS MUST FIRST UPDATE THEIR COLOR TABLE AND THEN REPLACE THE OLD WORK ZONE CELLS (or Update if the new work zone cells are already used):
1. Update color table by selecting Tools -> Color Table in the Color Table select File -> Default and click Attached Client.
2. Replace the old work zone cells using the Replace Cells icon command. Select /Add -> Cells -> Replace Cells. Set the Method to Replace and either Single or Global mode (Single will just replace that one cell, Global replaces all cells matching the selected cell's name). Then select the cell to replace and accept it.

For additional information, email HQCAEHelpDesk@wsdot.wa.gov.

DESIGNER NOTES:

A. For more information, guidance, and considerations for freeway rolling slowdowns, see WSDOT Traffic Manual Section 5-21. This section contains a rolling slowdown equation and sample calculations for reference for unique, site-specific rolling slowdown scenarios.

B. Contact Region Traffic Operations for information regarding their standard practices, permitted days & hours rolling slowdowns may occur, and any additional information.

C. List any rolling slowdowns restrictions (permitted days & hours & specific work operations) on traffic control plan and/or in the Contract Provisions. There is a text box on Sheet 3 set up for this already; modify as needed.

D. These typical traffic control plans may be modified for site specific situations and/or WSDOT Region Traffic Operations standard practices.

E. Channelization devices may be modified from those shown on these typical plans. Vertical panel channelization devices are prohibited. Using warning lights on channelization devices is being phased out in Washington. Contact Region Traffic Operations for information regarding their standard practices.

FREEWAY ROLLING SLOWDOWN FOR 45 THRU 70 MPH (TRUCKS 60) ZONES
NOT TO SCALE

FILE NAME:  182FwyRS.dgn  TIME:  03:55:05 PM  DATE:  1/14/2022

WASH  10  WASH  10  WASH  10

WASHINGTON STATE DEPARTMENT OF TRANSPORTATION

LOCATION NO.:  CONTRACT NO.:  JOB NUMBER:

REGIONAL ADM.

REVISION DATE:  DATE:  DATE:

P.E. STAMP BOX:  P.E. STAMP BOX:

See https://www.wsdot.wa.gov/Design/CAE/Technotes.htm for technical support and guidance.

Manually update or replace Microstation cells at least annually.

(1) Manually install updated WSDOT cell libraries into Microstation. See https://www.wsdot.wa.gov/Design/CAE/Updates.htm for download and installation instructions.

(2) Replace the old work zone cells using the Replace Cells icon command. Select /Add -> Cells -> Replace Cells. Set the Method to Replace and either Single or Global mode (Single will just replace that one cell, Global replaces all cells matching the selected cell's name). Then select the cell to replace and accept it.

For additional information, email HQCAEHelpDesk@wsdot.wa.gov.

DESIGNER NOTES:

A. For more information, guidance, and considerations for freeway rolling slowdowns, see WSDOT Traffic Manual Section 5-21. This section contains a rolling slowdown equation and sample calculations for reference for unique, site-specific rolling slowdown scenarios.

B. Contact Region Traffic Operations for information regarding their standard practices, permitted days & hours rolling slowdowns may occur, and any additional information.

C. List any rolling slowdowns restrictions (permitted days & hours & specific work operations) on traffic control plan and/or in the Contract Provisions. There is a text box on Sheet 3 set up for this already; modify as needed.

D. These typical traffic control plans may be modified for site specific situations and/or WSDOT Region Traffic Operations standard practices.

E. Channelization devices may be modified from those shown on these typical plans. Vertical panel channelization devices are prohibited. Using warning lights on channelization devices is being phased out in Washington. Contact Region Traffic Operations for information regarding their standard practices.